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GroupWise 6.5 for Linux 
Support Pack 2
June 15, 2004

Overview
The information in this Readme file pertains to Novell® GroupWise® 6.5 for Linux Support Pack 
2. This Support Pack contains updates for all components contained in the GroupWise 6.5 for 
Linux product. However, this Support Pack does not contain updates for GroupWise Messenger. 
GroupWise Messenger 1.0 for Linux Support Pack 2 is a separate download.

The primary purpose of GroupWise 6.5 for Linux Support Pack 2 is to add support for the 
following 10 languages in the GroupWise Cross-Platform client:

- Arabic
- Chinese-Simplified
- Chinese-Traditional
- Czech
- Hebrew
- Hungarian
- Japanese
- Korean
- Polish
- Russian

Some additional improvements have also been made.

For information on the latest Support Pack issues, see the Consolidated Support Pack Readme 
Addendum (http://support.novell.com/cgi-bin/search/searchtid.cgi?/10091736.htm), where issues 
for GroupWise 6.5 for Linux Support Pack 2 are available along with issues for GroupWise 6.5 
Support Pack 2.

1.0  Support Pack Installation

1.1  GroupWise Version Information
GroupWise 6.5 for Linux Support Pack 2 must be applied to the following GroupWise version in 
your software distribution directory:

GroupWise 6.5 for Linux (original version)

The GroupWise 6.5 for Linux software distribution directory must already exist in order to install 
Support Pack 2. When you update the software distribution directory, all GroupWise components 
should be updated to keep them at the same version level.

Do not apply GroupWise 6.5 for Linux Support Pack 2 to any non-Linux software distribution 
directory such as GroupWise 6.5 or GroupWise 6.5 Support Pack 1.
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1.2  Downloading and Installing the Support Pack
GroupWise 6.5 for Linux Support Pack 2 is available as compressed tar files. You can download 
the full Support Pack as a single download. You can also download the GroupWise Cross-Platform 
clients for Linux* and Macintosh* as separate downloads.

1.2.1  Downloading and Installing the Full Support Pack

The full Support Pack includes both administrative and client files.

1 Download the compressed tar file (gwlinux652.tar.gz) to a temporary directory on your Linux 
server.

2 In a terminal window at your Linux server, change to the temporary directory, then use the 
following commands to uncompress and untar the downloaded file:

gzip -d gwlinux652.tar.gz
tar -xvf gwlinux652.tar

The result is a directory named gwlinux652.

3 Change to the gwlinux652 directory.

4 Enter the following command:

xhost + localhost

5 In the same window, become root by entering su and the root password.

6 Start the GroupWise Installation Advisor:

./install

7 Click Create or Update a GroupWise System.

8 Follow the on-screen instructions to update the software distribution directory and the 
administration, agent, and client software that is in production.

For more information, see the GroupWise 6.5 Installation Guide located in the /docs/us 
subdirectory of the Support Pack.

1.2.2  Downloading and Installing the Cross-Platform Client for Linux

1 Download the compressed tar file (gw652clnx.tar.gz) to a temporary directory on your Linux 
workstation.

2 In a terminal window at your Linux workstation, change to the temporary directory, then use 
the following commands to uncompress and untar the downloaded file:

gzip -d gw652clnx.tar.gz
tar -xvf gw652clnx.tar

The result is a directory named gw652clnx.

3 Change to the gw652clnx directory.

4 Start the GroupWise Setup Advisor:

./install

5 To start the Cross-Platform client after installation, click the GroupWise icon on your Linux 
desktop.
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1.2.3  Downloading and Installing the Cross-Platform Client for Macintosh

1 Download the StuffIt file (gw652cmac.sit) to a temporary directory on your Macintosh 
workstation.

2 At your Macintosh workstation, browse to the gw652cmac.sit file.

3 Double-click the gw652cmac.sit file to uncompress the downloaded file.

The result is a directory named gw652cmac.

4 Change to the gw652cmac directory.

5 Double-click the GroupWise.app.sit file to install the GroupWise Cross-Platform client 
software.

6 To start the Cross-Platform client after installation, click the GroupWise icon on your 
Macintosh desktop.

2.0  Installation Issues

2.1  Multiple Agents on the Same Server
After you have installed the GroupWise 6.5 for Linux Support Pack 2 versions of the POA and the 
MTA, any existing Internet Agent, WebAccess Agent, or Monitor Agent installed on the same 
server no longer runs. You must update all agents on the same server to GroupWise 6.5 for Linux 
Support Pack 2 in order for the agents to run correctly.

2.2  WebAccess and Monitor on the Same Web Server
The WebAccess Application, WebPublisher Application, and Monitor Application share a 
common library. If you plan to run these applications on the same Web server, you must update 
all three before any of them can work properly.

2.3  Wireless Device Support for WebAccess and Monitor
The GroupWise® WebAccess and Monitor software included in GroupWise 6.5 for Linux Support 
Pack 2 supports the following wireless devices:

WAP-enabled wireless devices that use HDML 3 or WML 1.1 compatible microbrowsers

Palm OS* devices

We are continually evaluating and adding support. As we add support for additional devices, we 
post the updates at the Novell GroupWise Wireless Web site (http://www.novell.com/wireless). 
We encourage you to check this site frequently for updates and news.

2.4  Additional Installation Issues
Installation issues for individual GroupWise components are located under the heading for each 
component.
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3.0  Component Issues

3.1  Administration Issues

3.1.1  NFS Not Supported

Because of long-standing file lock issues with NFS, you cannot use an NFS mount to mount a 
server file system where your GroupWise system is located to a workstation where you are running 
ConsoleOne®. We recommend using an SMB mount instead.

3.1.2  Pathnames and Filenames in Lowercase

All directory names in paths to GroupWise domains and post offices should consist of lowercase 
letters. Filenames should also consist of lowercase letters.

3.1.3  Server Names

When filling in a UNC Path field in ConsoleOne, you must specify the server name. You cannot 
use an IP address or DNS host name. On Linux*, ConsoleOne translates UNC paths into Linux 
paths.

3.1.4  Display Problem with ConsoleOne Property Page Tabs

If you run ConsoleOne on SUSE® LINUX 9 with Ximian® Desktop 2 installed, the label text on 
the property tabs does not display. As a workaround, click the tab to select it, then use the up-arrow 
and down-arrow keys to display each property page until you reach the one you want.

3.1.5  Unavailable Administration Features

GroupWise 6.5 for Linux does not include the following administration features that are available 
in GroupWise 6.5:

Import/Export utility in ConsoleOne

Document Properties Management feature in ConsoleOne

3.2  Agent Issues

3.2.1  Floating Point Exception Error

On Red Hat* Enterprise Linux 3 and Red Hat Advanced Server 3, starting the POA or MTA might 
result in a "floating point exception" error. If this occurs, you must enter the following prior to 
starting the POA or MTA:

export LD_ASSUME_KERNEL=2.4.0

If you start the POA or MTA using the grpwise startup script in /etc/init.d, this error does not occur 
because the script sets the LD_ASSUME_KERNEL environment variable for you.

3.2.2  libXm.so.3 Error

If you try to start the POA or MTA on a server where The X Window System* and OpenMotif are 
not running, you receive the following error:
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libXm.so.3: cannot open shared object file
: no such file or directory

To resolve the error, start The X Window System and OpenMotif before starting the POA or MTA 
with the --show switch. If you start the POA or MTA without the --show switch, you can use the 
agent’s Web console to monitor the agent from your Web browser.

3.3  Cross-Platform Client Issues

3.3.1  Linux Client Installation on Red Hat 8

On Red Hat 8, you cannot use the main GroupWise Installation Advisor (the install executable at 
the root of the Support Pack) to install the Cross-Platform client. Instead, you can run the install 
executable located in /client/linux or you can install the novell-groupwise-gwclient-6.5.2 RPM 
located in the same directory.

3.3.2  Cross-Platform Client Performance

For best performance, run the Cross-Platform client in Caching mode. It is noticeably faster than 
Online mode.

3.3.3  Running as root in Caching Mode

If you run the Cross-Platform client in Caching mode as root on Linux, you might encounter 
synchronization problems with your master mailbox when you next run as a regular user. If 
pending requests from the root session remain when you log in as a regular user, regular user 
requests get backed up behind the root requests, which cannot be processed while you are logged 
in as a regular user. To resolve any problems, run the client as root again so that all messages get 
synchronized, then run as a regular user thereafter to prevent further problems.

3.3.4  HTML Message Display

Some HTML-formatted messages are not rendered correctly in the Cross-Platform client.

3.3.5  Some Settings Not Saved

In Online mode, custom column sort settings are not saved unless the Cross-Platform client is 
connected to a GroupWise 6.5 for Linux POA or later. The problem will be resolved for NetWare® 
and Windows* POAs in a future Support Pack.

3.3.6  “Not Accepting Jobs” Print Error

This is a Java* error. A newer version of the JVM* resolves it. The print jobs prints successfully 
in spite of the error message.

3.3.7  Mailbox Size Limits Not Recognized

The Cross-Platform client does not recognize the mailbox size limits set in ConsoleOne (Tools > 
GroupWise Utilities > Client Options > Send > Disk Space Management).
5



    Novell Confidential                                                                                            Manual (ENU)  15 April 2004
3.3.8  Bold Not Displaying on Macintosh

If you have installed Microsoft* Office or Internet Explorer on your Macintosh, new messages 
might not display as bold in your mailbox. To resolve the problem, disable your user fonts, which 
are typically duplicates of your system fonts, or update to JVM 1.4.2 Update 1 or later.

3.3.9  Unavailable Client Features

The GroupWise Cross-Platform client does not currently provide some functionality that is 
available in the GroupWise Windows client, including:

Spell checking

Rules

Categories

Viewers for attachments

Remote mode to support modem connections

S/MIME (encryption and digital signatures)

Document management

Additional functionality will be available in future releases of the Cross-Platform client.

3.4  Internet Agent Issues

3.4.1  Installation Security

During installation, the Internet Agent Installation program requires access to Novell® 
eDirectoryTM by way of LDAP authentication. The LDAP Group object includes an option named 
Require TLS for Simple Binds with Password, which is enabled by default. With this option 
enabled, you must provide the LDAP server’s Trusted Root Certificate, which must be exported 
from the LDAP server, in order for LDAP authentication to take place (typically on port 636) 
during installation of the Internet Agent.

Unless you already have SSL set up, an easier alternative is to disable Require TLS for Simple 
Binds with Passwords in ConsoleOne, which allows LDAP authentication to take place using clear 
text (typically on port 389), during installation of the Internet Agent. After disabling the option, 
restart eDirectory, install the Internet Agent, then re-enable Require TLS for Simple Binds with 
Password and restart eDirectory again.

3.4.2  Floating Point Exception Error

On Red Hat Enterprise Linux 3 and Red Hat Advanced Server 3, starting the Internet Agent might 
result in a "floating point exception" error. If this occurs, you must enter the following prior to 
starting the Internet Agent:

export LD_ASSUME_KERNEL=2.4.0

If you start the Internet Agent using the grpwise-ia startup script in /etc/init.d, this error does not 
occur because the script sets the LD_ASSUME_KERNEL environment variable for you.

3.4.3  libXm.so.3 Error

If you try to start the Internet Agent on a server where The X Window System and OpenMotif are 
not running, you receive the following error:
6   



    Novell Confidential                                                                                            Manual (ENU)  15 April 2004
libXm.so.3: cannot open shared object file
: no such file or directory

To resolve the error, start The X Window System and OpenMotif before starting the Internet Agent 
with the --show switch. If you start the Internet Agent without the --show switch, you can use the 
Internet Agent Web console to monitor the Internet Agent from your Web browser.

3.4.4  Address Resolution Change Since GroupWise 6

In GroupWise 6 and its Support Packs, there was a problem with the address format used for 
sending to distribution lists and resources if you set Internet Addressing to one of the following 
formats (which are not appropriate for distribution lists and resources):

first_name.last_name@Internet_domain

last_name.first_name@Internet_domain

Messages to distribution lists and resources were initially undeliverable and were sent to the 
Internet Agent. The Internet Agent then successfully resolved the addresses and sent the messages 
back into the GroupWise system. Users did not notice the problem, but some administrators 
noticed unnecessary traffic through the Internet Agent.

In GroupWise 6.5 and GroupWise 6.5 for Linux, the address format problem for sending to 
distribution lists and resources was corrected. However, users who originally used GroupWise 6 
have the erroneous address format for distribution lists and resources in their Frequent Contacts 
address books. If unnecessary traffic through the Internet Agent is a continuing problem, have 
users delete distribution lists and resources from their Frequent Contacts address books so that the 
correct address format is used for name completion in the future.

3.5  WebAccess Issues

3.5.1  Novell Distribution of Apache and Tomcat

GroupWise 6.5 for Linux includes a Novell distribution of Apache and Tomcat that you can install 
along with the WebAccess Application if you do not already have Apache and Tomcat running on 
that server. The Novell distribution is installed in the following directories:

Apache: /var/opt/novell/http and /etc/opt/novell/http
Tomcat: /var/opt/novell/tomcat4 and /etc/opt/novell/tomcat4

and is started using the following customized commands:

Tomcat: /etc/init.d/novell-tomcat4 start
Apache: /etc/init.d/novell-httpd start

The WebAccess Installation program lets you choose whether you want to install the Novell 
distribution. During installation, select Install WebAccess Application with Apache and Tomcat 
if you want to install the Novell distribution. Select Install WebAccess Application if you do not 
want to install the Novell distribution of Apache and Tomcat because you have an existing Apache 
and Tomcat installation that you want to use with WebAccess.

If you install the Novell distribution on a server where a standard distribution of Apache and 
Tomcat is already installed and running, you will encounter a port conflict on port 80. You can 
resolve the port conflict by choosing to run one distribution or the other, or you can reconfigure 
one distribution or the other.
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To reconfigure the Novell distribution to use a different port number, edit the httpd.conf file in the 
/etc/opt/novell/httpd/conf directory. Locate the following line:

Listen 80

Change the port number to a something that is not already being used on the server, then save and 
exit the file.

3.5.2  Prolonged “Please Wait” Message during Installation

On slower machines, if you select Install WebAccess Application with Apache and Tomcat, your 
machine might appear to hang on the “Please Wait” message. Apache and Tomcat are being 
installed while the “Please Wait” message is displayed, before the WebAccess Application 
installation begins.

3.5.3  Installation Security

During installation, the WebAccess Installation program requires access to Novell® eDirectoryTM 
by way of LDAP authentication. The LDAP Group object includes an option named Require TLS 
for Simple Binds with Password, which is enabled by default. With this option enabled, you must 
provide the LDAP server’s Trusted Root Certificate, which must be exported from the LDAP 
server, in order for LDAP authentication to take place (typically on port 636) during installation 
of the WebAccess.

Unless you already have SSL set up, an easier alternative is to disable Require TLS for Simple 
Binds with Passwords in ConsoleOne, which allows LDAP authentication to take place using clear 
text (typically on port 389), during installation of WebAccess. After disabling the option, restart 
eDirectory, install WebAccess, then re-enable Require TLS for Simple Binds with Password and 
restart eDirectory again.

3.5.4  Re-installation Issue

If you install WebAccess in an eDirectory context where the WebAccess objects already exist, a 
message informs you that you can “use the existing objects.” In actuality, the objects are deleted 
and re-created, so if you have customized the properties of the existing objects, you must 
customize the objects again after installing WebAccess. 

3.5.5  Floating Point Exception Error

On Red Hat Enterprise Linux 3 and Red Hat Advanced Server 3, starting the WebAccess Agent 
might result in a "floating point exception" error. If this occurs, you must enter the following prior 
to starting the WebAccess Agent:

export LD_ASSUME_KERNEL=2.4.0

If you start the WebAccess Agent using the grpwise-wa startup script in /etc/init.d, this error does 
not occur because the script sets the LD_ASSUME_KERNEL environment variable for you.

3.5.6  Version Number Update

After you have updated the WebAccess and WebPublisher Applications to GroupWise 6.5 for 
Linux Support Pack 2, the GroupWise version number on the login page and under Help > About 
still displays 6.5.1. To correct the version number:

1 In a text editor, open the following configuration files:
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/opt/novell/groupwise/webaccess/webacc.cfg
/opt/novell/groupwise/webpublisher/webpub.cfg

2 Change the setting for Application.Display.version from 6.5.1 to 6.5 to reflect the major 
version number on the login page.

3 Change the setting for Application.Module.version from 6.5.1 to 6.5.2 to reflect the Support 
Pack release number under Help > About.

4 Save and exit each configuration file.

5 Restart Tomcat to put the version changes into effect.

3.5.7  New WebAccess URLs

Existing users of the WebAccess are accustomed to accessing the following URLs:

Web Services page: Default index.html file of the Web server
WebAccess: http://web_server_address/servlet/webacc
WebPublisher: http://web_server_address/servlet/webpub

On Linux, use the following URLs:

GroupWise-specific Web Services page: http://web_server_address/gw/index.html
WebAccess: http://web_server_address/gw/webacc
WebPublisher: http://web_server_address/gw/webpub

As an added benefit, GroupWise 6.5 for Linux configures SSL for you, so that the following URLs 
provide SSL security without additional configuration on your part:

GroupWise-specific Web Services page: https://web_server_address/gw/index.html
WebAccess: https://web_server_address/gw/webacc
WebPublisher: https://web_server_address/gw/webpub

3.5.8  WebAccess Spell Checker Download Issue for Mozilla 1.6

The first time you use the WebAccess spell checker, it downloads a speller plug-in. If Mozilla 1.6 
is not configured correctly, you are repeatedly prompted to download the plug-in but the download 
never succeeds. The following URL might be of assistance in configuring Mozilla 1.6 so that the 
plug-in can be downloaded successfully:

http://www.mozilla.org/releases/mozilla1.6/installation-extras.html#extras_java 

3.5.9  WebPublisher Configuration

The WebAccess Installation program does not configure WebPublisher for you. Some manual 
configuration is required. For instructions, see the GroupWise 6.5 Installation Guide (/docs/us/
GroupWiseInstallationGuide.pdf).

3.5.10  WebPublisher Template Settings Not Saved

Changes to the settings on the Templates page of the GroupWiseWebPublisher object in 
ConsoleOne are not saved to the webpub.cfg file. To work around this, after making changes on 
the Templates page, select a different property page on the GroupWiseWebPublisher object, then 
click OK or Apply to save the template settings correctly.
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3.5.11  Login Page Reappears after Successful Login

If the WebAccess login page appears in one or more of the frames (for example, the Folder list or 
the Item list) after a WebAccess user has successfully logged in, the user is probably accessing 
WebAccess through one or more proxy servers.

To prevent this problem:

1 In ConsoleOne, right-click the WebAccess Application object (GroupWiseWebAccess), then 
click Properties.

2 On the Security page (located on the Application tab), deselect the Use Client IP in Securing 
Sessions option. 

For information about this option, click Help on the Environment page.

3 Click OK to save the change.

3.5.12  Recommendation for Tomcat Memory Allocation (Heap Size)

If you are using the Tomcat servlet engine with GroupWise WebAccess, the maximum memory 
allocation (heap size) for Tomcat should be at least 128 MB. The maximum memory allocation is 
set by using the -Xmx parameter when starting Tomcat (for example, -Xmx128m).

3.6  Monitor Issues

3.6.1  Monitor Issues Shared with WebAccess

Monitor and WebAccess share a substantial amount of functionality. The following WebAccess 
issues pertain to Monitor as well:

2.5.1 Novell Distribution of Apache and Tomcat
2.5.2 Prolonged “Please Wait” Message during Installation
2.5.3 Installation Security
2.5.4 Re-installation Issue
2.5.5 Floating Point Exception Error
2.5.6 Version Number Update

3.6.2  New Monitor URLs

If you’ve used Monitor on Windows, you are used accustomed to accessing the following URLs:

Web Services page: Default index.html file of Web server
Monitor Web Console: http://web_server_address/servlet/gwmonitor

On Linux, use the following URLs:

GroupWise-specific Web Services page: http://web_server_address/gw/index.html
Monitor Web Console: http://web_server_address/gwmon/gwmonitor

3.6.3  Problem Starting Monitor on Red Hat 3 AS

If you encounter problems starting the Monitor Agent on Red Hat 3 AS, set the LC_ALL 
environment variable using one of the following commands:

export LC_ALL=C
export LC_ALL=POSIX
10   



    Novell Confidential                                                                                            Manual (ENU)  15 April 2004
3.6.4  Restoring Monitor Settings after Reinstallation

Monitor settings are stored in the monitor.xml file in the Monitor installation directory. If you 
reinstall the Monitor software, the monitor.xml file is backed up as monitor.001. To restore 
previous Monitor settings, remove the newly installed monitor.xml file and rename monitor.001 
to monitor.xml.

4.0  International Issues

4.1  Extended Characters in Pathnames and Filenames
Do not use extended characters in pathnames for domains, post offices, libraries, software 
distribution directories, and so on. Do not use extended characters in filenames such as agent 
startup files.

4.2  Extended Characters in Attachment Filenames
If you are using the WebAccess client in the Konqueror browser, you cannot attach files that have 
names including accented characters. Konqueror does not send the filenames back in UTF-8 
format.

4.3  Double-Byte Characters in Directory Names and Filenames
Do not use double-byte characters in directory names and filenames.

4.4  Double-Byte Characters in Passwords
Do not use double-byte characters in users' passwords. 

The Change GroupWise Password dialog box in ConsoleOne currently allows entry of double-
byte characters. However, the GroupWise client login does not allow entry of double-byte 
characters in passwords, so a user who was assigned a password with double-byte characters in 
ConsoleOne cannot type the double-byte characters when attempting to log in to GroupWise.

4.5  Russian Keyboard
When you use a Russian keyboard, the Linux environment variables that provide language and 
locale information are typically set to ru_RU. Typically, this setting implies the Russian character 
set ISO-8859-5. However, on some distributions of Linux, the ISO-8859-5 character set must be 
set explicitly in order for your Russian keyboard to work with the GroupWise Cross-Platform 
client. Use the following command to specify the character set along with the language and locale 
information:

export LANG=ru_RU.ISO-8859-5

In most cases, setting the LANG environment variable also sets all LC_* environment variables 
and resolves all Russian keyboard problems. If you set the LANG environment variable and your 
Russian keyboard still does not work, use the following command to view the current settings for 
the LANG and LC_* environment variables:

locale
11
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If any of the LC_* environment variables have not inherited the ISO-8859-5 specification, export 
them individually.

4.6  Mnemonics for Arabic, Hebrew, and Double-Byte Languages
Keyboard mnemonics for menu items work for characters a-z and A-Z, but not for other characters.

4.7  Localized Agent User Interface Display
The Linux GroupWise agent user interfaces display correctly if the Linux environment is using the 
ISO-8859-1 character set, which is the default for the GroupWise administration languages and 
locales.

French: fr_FR
German: de_DE
Portuguese: pt_BR
Spanish: es_ES

If the Linux environment is using a different character set encoding such as UTF-8 (for example, 
fr_FR.UTF-8), the localized agent user interfaces do not display correctly.

4.8  Unicode Support in WebAccess
Unicode* support using UTF-8 encoding has been implemented in WebAccess to provide better 
support for international character sets. Unicode support enables users to intermix characters 
within the same message and have all character sets display correctly.

For Support Pack 2, Unicode support is not fully implemented for double-byte character set 
languages (DBCS languages). In order to correctly compose in a DBCS language, users need to 
set their browser accept language to the desired DBCS language. Also in Support Pack 2, 
intermixing two different DBCS languages is not supported. These limitations will be removed in 
the next version of WebAccess.

If you will update to Support Pack 2 in stages, update the WebAccess Agent first throughout your 
system, then update the WebAccess Application. If the update to Unicode support causes 
undesirable side effects for your particular language or combination of languages, you can turn it 
off using the /utf8off startup switch with the WebAccess Agent. Then comment out the 
Charset.default setting in the webacc.cfg and webpub.cfg files. This procedure will not be 
necessary after Unicode support is fully supported for DBCS languages.

4.9  Character Encoding in WebAccess
Auto-detection of character encoding for the WebAccess/WebPublisher index.html page does not 
work for some Web browsers. If you do not see the localized languages in the drop-down menu 
on the Web services page (index.html), set your browser’s character encoding to UTF-8 (for 
example, click View > Encoding).

You might also encounter character encoding problems when reading HTML-formatted messages. 
In this case, set your browser’s character encoding for the new message window to UTF-8. You 
can do this by right-clicking in the message and then setting the encoding or using View > 
Encoding.
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5.0  Documentation Issues

5.1  Right-to-Left Text in Cross-Platform Client Help
Languages that display right-to-left display right-justified rather than left-justified.

5.2  Web Link in ConsoleOne Help
The link from the ConsoleOne help to the Novell GroupWise documentation Web site does not 
work. This problem will be addressed in a future version of ConsoleOne. In the meantime, you can 
copy the URL from the ConsoleOne help topic into your browser window in order to access the 
GroupWise documentation Web site.

5.3  Help Image Display on an iChain Server
If you display help from an agent Web console on a server where Novell iChain® is installed, and 
if iChain is configured to use the Path-Based Multihoming option, the image at the top of the help 
topic does not display.

6.0  Defect Fixes

6.1  Installation Fixes
The Installation program makes sure you are logged in as root before starting the installation 
process.(369789) 

6.2  Administration Fixes
In ConsoleOne, the remote document storage area path is stored in UNC path format.(372321, 
372218) 

The DBCopy utility as been enhanced to back up domain directory structures as well as post 
office directory structures.(368881, 365360) 

The new DBCopy -I startup switch enables you to perform incremental backups. Use the 
format -I mm-dd-yyyy to specify a date. DBCopy then backs up only files that are newer than 
the specified date.(364410)  

DBCopy can back up a post office that is located on a NetWare server.(366355) 

DBCopy can recognize directory names and filenames in uppercase and lowercase 
letters.(369571, 371502) 

DBCopy handles the change to and from daylight saving time correctly.(366087) 

DBCopy provides date and time information in its log files.(369481) 

DBCopy can copy zero-byte files.(366055) 

The GroupWise Time Stamp utility is now available on Linux.(367019) 

6.3  Agent Fixes
The MTA SNMP processing no longer sends out hexadecimal characters in traps.(366155) 
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MIME message headers now include the content type.(100367359) 

MIME bodies no longer contain the extraneous multipart alternative when an HTML 
attachment is present.(100367727) 

6.4  Cross-Platform Client Fixes
If you have enabled signatures and you reply to or forward a message from an external e-mail 
system, your signature is added.(368497) 

You can edit an existing posted item.(368529) 

If you display an HTML-formatted item in Plain Text view, and if you then copy and paste a 
URL that includes hyphens (-), the hyphens are no longer replaced with spaces.(368204) 

A clock icon appears beside the Calendar folder when you have an appointment on the current 
day.(368608) 

Changing the time of an appointment no longer affects the selected date.(373099) 

Status tracking icons appear in the Sent Items folder.(366872) 

In the Address Book window, you can right-click an address book, then click Delete Book to 
delete the address book.(369060) 

In the Address Book, you can enter Web site information about a new contact while creating 
the contact.(367487) 

You can use the Address Selector to select a user to add to your proxy list.(369414) 

In Caching mode, you can use Find several times in succession when no results are returned 
from a search.(270024) 

Under Tools > Options > Extension, you can remove a file extension from the list.(371084) 

Extraneous HTML codes are no longer added to posted items when the message body is 
empty and the items is opened multiple times.(371585, 372097) 

The Cross-Platform client recognizes the setting of the Allow Purge of Items Not Backed Up 
option in ConsoleOne and prevents deletion of items if the option is deselected.(369456) 

The Cross-Platform client starts successfully when the administrator has forced Caching 
mode with a grace period in ConsoleOne.(368553) 

In the Macintosh client, the access list in Proxy Access dialog box displays correctly.(367912) 

Fixed a memory leak.(368546) 

6.5  Engine Fixes
None.

6.6  GWCheck Fixes
You no longer need to be root to run GWCheck on your Caching database.(364507) 

GWCheck can resolve "Invalid user found" and "Unable to correct display name" errors in 
library databases.(336301) 

GWCheck no longer hangs when running on SUSE Linux Enterprise Server 8.(368405) 
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6.7  Internet Agent Fixes
MIME message headers now include the content type.(100367359) 

MIME bodies no longer contain the extraneous multipart alternative when an HTML 
attachment is present.(100367727) 

When handling heavy message traffic where many of the messages are coming from blocked 
senders, the Internet Agent waits for a QUIT signal and then terminates the connection, or if 
no QUIT signal is received in a specified amount of time, the Internet Agent drops the 
connection.(373396) 

Fixed several Internet Agent core dumps.(338890, 369835, 100354479) 

6.8  Monitor Fixes
None.

6.9  WebAccess Fixes
In a post office where security is set to High with LDAP authentication, the WebAccess client 
can log in to your mailbox if your password includes a hyphen (-).(355783) 

A very large address book (over 6,000 entries) is included in the list of available address books 
in the WebAccess client.(370266) 

In the HTML address book in the WebAccess client, you can change the number of names to 
display after searching and have the number remain set after you select names from the search 
results.(369645) 

“Not available” errors no longer display when viewing documents in WebPublisher.(368132) 

7.0  Documentation

7.1  Support Pack Readme Addendum
For information on the latest Support Pack issues, see the Consolidated Support Pack Readme 
Addendum (http://support.novell.com/cgi-bin/search/searchtid.cgi?/10091736.htm), where issues 
for GroupWise 6.5 for Linux Support Pack 2 are available along with issues for GroupWise 6.5 
Support Pack 2.

7.2  GroupWise 6.5 Installation Guide
For detailed installation and update instructions, see the GroupWise 6.5 Installation Guide at the 
Novell Documentation Web site (http://www.novell.com/documentation). It has been updated to 
correspond with GroupWise 6.5 for Linux Support Pack 2.

7.3  GroupWise 6.5 Administration Guide
For additional GroupWise 6.5 documentation, see the GroupWise 6.5 Administration Guide at the 
Novell Documentation Web site (http://www.novell.com/documentation). It has been updated to 
correspond with GroupWise 6.5 for Linux Support Pack 2.
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7.4  Original GroupWise 6.5 Readme Files
For Readme information about specific GroupWise 6.5 components, see the following additional 
Readme files that shipped with the original release of GroupWise 6.5:

Administration: \admin\readmeus.txt
Agents: \agents\readmeus.txt
Client: \client\win32\readmeus.txt
WebAccess: \internet\webaccess\readmeus.txt
Internet Agent:\internet\gwia\readmeus.txt
Monitor: \admin\monitor\readmeus.txt

These Readme files do not contain Support Pack information.

8.0  Documentation Conventions
In this documentation, a greater-than symbol (>) is used to separate actions within a step and items 
in a cross-reference path.

A trademark symbol (®, TM, etc.) denotes a Novell trademark; an asterisk (*) denotes a third-party 
trademark.

9.0  Legal Notices
Novell, Inc. makes no representations or warranties with respect to the contents or use of this 
documentation, and specifically disclaims any express or implied warranties of merchantability or 
fitness for any particular purpose. Further, Novell, Inc. reserves the right to revise this publication 
and to make changes to its content, at any time, without obligation to notify any person or entity 
of such revisions or changes.

Further, Novell, Inc. makes no representations or warranties with respect to any software, and 
specifically disclaims any express or implied warranties of merchantability or fitness for any 
particular purpose. Further, Novell, Inc. reserves the right to make changes to any and all parts of 
Novell software, at any time, without any obligation to notify any person or entity of such changes.

You may not use, export or re-export this product in violation of any applicable laws or regulations 
including, without limitation, U.S. export regulations or the laws of the country in which you 
reside.

U.S. Patent Nos. 4,555,775; 4,580,218; 5,412,772; 5,701,459; 5,717,912; 5,760,772; 5,870,739; 
5,873,079; 5,884,304; 5,903,755; 5,913,209; 5,924,096; 5,946,467; 5,963,938; 6,081,804; 
6,138,170; 6,167,393; 6,192,405; 6,216,123; 6,546,433; 6,584,458; D393,457; and Patents 
Pending.

Copyright © 2004 Novell, Inc. All rights reserved. No part of this publication may be reproduced, 
photocopied, stored on a retrieval system, or transmitted without the express written consent of the 
publisher.

GroupWise and Novell are registered trademarks of Novell, Inc. in the United States and other 
countries.

All third-party trademarks are the property of their respective owners.
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